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Chapter 5 - Patient Letters

Step-Ahead boasts a sophisticated built-in word processing facility which will aid you in taking
care of your written correspondence, both to your clients and to other businesses.

The basics of Step-Ahead word processing
In order to make full use of letter writing in Step-Ahead, there are a few basic terms and
concepts that need explaining.

Document (Letter)

A letter can either be prepared using a template or can be typed in directly by the user. In either
case letters can be distinguished from templates by a date appearing next to their name, rather
than the word "template™. Step-Ahead automatically organises letters according to the patient
name you currently have open. That is, when you open the letters window you will only see the
letters that you have saved for that specific patient.

Template
A special file created by the user that can be used repeatedly for letter preparation. Templates

are "pro-formers" that usually contain references to database fields within Step-Ahead.
Templates are used when the user wishes to have database information automatically "filled-in"
by Step-Ahead. For example, you could create a simple template which would fill in the patient
name, address and the date onto a standardised medical certificate pro-former. Once created
this template can be used over and over for each patient, producing professional looking
certificates without the need to type. A template can only be created when there is a patient
name in the title bar. Once saved, however, that template will be available for every patient
that you may open. Templates can be recognised by the word "template™ next to the template
name. Once you have prepared a letter using a template, you can customise and then save it as a
letter.

Word wrap
When writing letters there is no need to press the enter key when the cursor reaches the right

hand edge of the screen. All word processing programs will automatically wrap a semi-
completed word down to the next line of your letter. Remember to just keep typing and Step-
Ahead will "word-wrap™ as you go.

Creating a patient letter

Before attempting to create letters you must have a patient name open at the top of the screen.
Make certain you have the correct patient open and press the PATIENT then LETTERS
commands to display the following window :

The letters main window

The letters window, although seemingly complex, is actually simple to use. When entering a
letter, you also have access to almost any other aspect of Step-Ahead simultaneously. For
example, it is possible to work on a letter for one particular patient and then quickly jump to the
accounts screen for another. When you have finished the extra task, you don't have to worry
about losing your place because your letter remains visible the whole time.
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The opertions area
Menu bar Toolbar Font bar Paragraph bar Ruler Status bar
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The operations area comprises the various bars. It is where all the document retrieval and text
formatting functions are available. The buttons here allow you to format text, change page sizes,
adjust margins or open previously saved letters or templates.

File Menu

New Opens a new blank window in which to begin typing

Open Displays a file search form in which to retrieve the file to open

Save Saves current open window into existing file or displays file save form
Save as ... Displays file save form in which to specify file name, type and location.

Save as JPEG ... Creates an image of the document and displays file save form to save it

Print Prints current open window
Print Preview Displays current open window as a printed document

Close Closes current open window with prompt to save it if it has changed

Exit Exits Trim Letters and returns to previous function.
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Letters Menu
Select>

New

Delete

Templates Menu
Select >

New

Edit >

Delete >

Insert Database Field..

Edit menu
Undo Input
Redo

Cut
Copy
Paste
Delete
Search...
Replace...

Select All [CtrI+A]

View Menu
Toolbar

Font bar
Paragraph bar
Ruler

Status bar

Control characters
Layout >
Zoom >

Insert Menu
Text...

Image >

OLE Object >
Table

Displays list of saved letters for this client to select one to open

Opens new blank window for typing letter or report

Displays list of saved letters for this client to select one to delete
Displays list of saved templates to select one to use as basis for new letter
Opens new blank window for typing a template

Displays list of saved templates to select one to edit as a template
Displays list of saved templates to select one to delete

Displays list of available database fields to choose one to insert at cursor
Undoes last typing, insert, edit or format function

Redoes last undo

Clears any highlighted text into the clipboard

Copies any highlighted text to the clipboard

Pastes any text from the clipboard to the document at cursor position

Clears any highlighted text without saving it to the clipboard

Displays search form to find specified text
Displays replace form to search and replace specified texts

Selects and highlights whole document for edit tasks above
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Format Menu
Text
Text Colour

Displays font form to change font properties of highlighted text.
Displays colour form to change colour of highlighted text

Text Background Colour Displays colour form to change background colour of highlighted text

Paragraph
Frames...
Table
Image...

Document...

Window Menu
Cascade

Tile horizontal
Tile Vertical
Arrange

[List of Names of open windows]

Help Menu
Contents...

About...

Toolbars

The toolbars contains shortcut buttons for the most commonly used functions.

From left to right they are:

DeEs

Y=

=

File buttons: New, Open, Save and Print.

Edit buttons: Cut, Copy and Paste

Opens video stills form to insert stills into document

=

Change document between portrait and landscape - remember to change printer properties
also to match before printing.
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||F'age Layout Center j E j

Adjusts typing page location and magnification in window

il
Il

Indents and outdents current paragraph

=
L

Change selected text font and colour characteristics

Toggles display or suppression of hidden characters such as paragraph marks

W

Spell check document or selected text

| sl | =2 =B 7 U

Font type, size, bold, italic and underline

[FEzs

Left, right, centre and justify paragraph alignment

it L1

Set left, right, decimal and not justified tabs on ruler

The ruler

The ruler area is designed primarily for allowing you to measure your page width. It has the
additional function of displaying any tab settings that you may have created in your document.
Tab settings are useful for aligning text in unusual places such as a placing a name or address on
the right hand side of the page, rather than the left.

The base measurement unit is inches and tab settings can be either left, right, centre or not
justified. To move a tab setting, Click directly on the appropriate marker and hold the mouse
button down. Now drag it to the new position. If entering a new tab setting just click using the
mouse in the desired location.
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The main text window

The main text window is where you type your document text . Your position within the letter is
shown by a small flashing vertical line called a "cursor". The main text window can be re-sized
and viewed in one of four possible modes.

The quick brown fox jurmped over the lazy dog. Mow it is tire for all goos men t
/‘ corme to the aid of the party. -

/

Main Text Area. Press this arrow to move the visible text area up or down.

The available viewing modes are: 25%, 50%, 75% and 100% modes.

The status bar
The status bar acts as your document "navigator”. The status bar makes it fast and easy for you
to locate where the cursor is currently positioned within the document.

Page 1 Line 2 Col 29 /X | INS HUM

The current page, line number, column position, insert mode and number mode can all be
viewed at any time.
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Miscellaneous letter functions

Formatting Text

Enter as much of your letters in one go as you can. It is far easier to "format"” your document
and make it look professional after you have entered your complete letter, rather than in small
repeated stages whilst typing.

Entering A New Letter
To start entering a new letter press the NEW LETTER speed button in the Operations Area.

ol

This will open a new window and place the cursor in the top left hand corner. You are now
ready to start typing.

Setting Letter Margins
The left, right, top and bottom margins can be easily changed within Step-Ahead letters by
sliding the left and right markers on the ruler.

Choosing Portrait / Landscape
The paper orientation can be toggled at any time by pressing the PORTRAIT / LANDSCAPE
speed button.

By

The current size of the paper is irrelevant to this operation. Pressing this speed button rotates
your document ninety degrees. It is important to note that when printing a landscaped document
you must be sure that the printer properties have also been adjusted to "landscape™ in order to
match your document.

Saving A Letter
Press the SAVE speed button :

To invoke the following window :

Save Az | x| |

Mame of Letter : | |

w./ Einish x Cancel ? Help
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Type the name you wish to use for your letter. You have a limit of eight characters (use only
alpha characters). Step-Ahead will limit you if you try to type more than this. Press the FINISH
button to store your letter. Once saved, you will notice this filename appearing in the Files list
(drop-down list) with a date beside it.

Printing A Letter
To print your typed letter press the PRINT speed button :

The following standard print options window will appear :

Print Ed
Frinter: Drefault Printer [HF Lazerlet 5P on -
WWEront desk sunihp]

~Frirt range Cancel

) Selection
! Pages
Erom; I}q T |1

Frint guality: IEEIEI dpi j Copies: |1

/ r c%jes
Choosing The V/ntRaqu

Press the All radio buttonA0 tell Step-Ahead to print all the pages in your document.
Press the Pages radio button and then enter values in the From and To fields.

Use :r1e/m>7/to modify the value in the Print Quality drop-down list box.
Charging Ahe Number Of Copies

Use the mouse or TAB key to click into the copies field and then type the number of copies that
you woutld like.

Modifying The Printer Setup
Press the SETUP button to modify additional details of the current print job.
Doing so will invoke the following window :
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Print Setup EHE3
' Default printer
[currently HP Lazerdet 5F on \\Front desk zunihp]
® Specific prnter:: Dptions. .
IHI:‘ Laserdet BP on \\Front desk sunihp j Network.. I
-Onenyation Paper
(® Portrait Size: ILetter 81/2x11in ;ﬂ
! Landscape Source: IUpper tray j
/

Selecting The Printer For A Letter

Press the Default Printer radio button to instruct Step-Ahead to route your letter to the printer
installed as the windows default.

Press the Specific Printer radio button and then select a printer from the Specific Printer drop-
down list. This instructs Step-Ahead that your letter will be routed only to the chosen printer.

Selecting Paper Orientation
Press the Portrait radio button to print your letter on vertical A4 paper.
Press the Landscape radio button to print your letter on horizontal A5 paper.

Selecting Paper Type
Use the mouse to print your letter on the desired paper size from the Size drop-down list.
Use the mouse to print your letter from the desired paper source from the Source drop-down list.

Modifying The Basic Printer Options

Press the OPTIONS button to open a printer specific settings window. Each printer will have a
visually different options window, however, they will almost allow you to modify : Economy
settings, graphics intensity, font selection and memory usage.

Selecting text in a letter

Text selection is needed to perform many of the basic tasks of the Step-Ahead word processor,
such as bolding, copying, enlarging or paragraph formatting. Text selection can occur in one
of two ways.

0 1 z 3 ) 5 B Use The Mouse
To Highlight
Move the mouse
pointer to the
start of the text
that you wish to
Here is some sample nonchighlighted text.  gElERt=Eelgy=Re=tgTal=R el Iel sl g =s R izEe g Her e highlight. Left-
is s01me samp!e nnrrh@gh!@gh?edl ?ex?. . IHer is same sample ”E'r.*h‘.g.h”.g.m'?'?' te?{t. Hera Click and HOLD

the mouse button down, moving the mouse to the end of the text to be highlighted. You will
notice the background of the text becomg inverted. Your text is now highlighted.
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Using Keystrokes To Highlight

Use the UP, DOWN, LEFT or RIGHT arrow keys to move the cursor to the start of the text to
be highlighted. Hold the SHIFT key down and use the UP, DOWN , LEFT or RIGHT arrow
keys to the move the cursor to the end of the text to be highlighted. You will notice as you move
the cursor that your text becomes inverted. Your text is now highlighted.

Select all
Press the SELECT ALL speed button to select and highlight your entire document.

4]

This is useful for Copying your whole document into the clipboard so you can later paste it into
another application.

[ ¥ ¥ ¥ ¥ ¥ ¥ ¥ B O |

F
1 1 2 2 4 I i

Copying,
cutting ,
and pasting
into letters
Step-Ahead
letters allows
you to cut,
copy and paste
text or images
using the clipboard. The clipboard is as an "invisible" temporary storage area that can hold any
data that you Copy or Cut into it. The clipboard cannot be seen, it is simply utilised when you
Cut, Copy or Paste.

Cutting Text From Your Letter

&
Select and highlight a portion of text and press the CUT button to remove the text from
your document and place it in the clipboard. This text can then be "Pasted"” back into the
document (or another document) at a later stage.

Copying Text From Your Document

Select and highlight a portion of text and press the COPY button ~—  to copy the text into the
clipboard. This text can then be "Pasted" back into the document (or another document) at a
later stage.
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Pasting Text Into Your Document

®
Place the cursor anywhere in your document and press the PASTE button speed button to
place the text from the clipboard into your document.

Finding specific words within text
Step-Ahead letters provides you with the facility to locate specific text within you written text.
Select Search from the Edit Menu to display the following window :

Find 21 x]
Cancel |

Direction
v Match case ’Vr Up & Down

Type the text you wish to find into the Find What text field.

Matching Case
Click on the Match Case check box to force the text search to match the case of your written text
to the text you have just typed.

Choosing The Search Direction

Press the UP or DOWN radio button to force the search to look "UP from™ or "DOWN from"
your current cursor position.

Press the FIND NEXT button to actually perform the search. Upon finding a match the text
window will move to the appropriate position within the document.

Replacing Specific Words Within Text
Select Replace from the Edit Menu to find and replace specific text within your document .This
will display the following window :

Find what: m Find Mead

Replace with: I Replace
Feplace Al

Cancel

e

¥ Match case

Type the text you wish to find in the Find What text field. Type the text you wish to replace it
with into the Replace With text field.

Page 12



Step-Ahead User Guide
Step-Ahead User’s Guide © Copyright 1998-2003. All Rights Reserved
Step-Ahead 2003, XP Compatible

Matching Case
Clicking on the Match Case check box will force the search to match the case of your written
text to the text you have just typed.

Press the FIND NEXT button to perform a search. Upon finding a match, the text window will
move to the appropriate position within the document.

Press the REPLACE button to replace the currently highlighted text with the text you typed in
the Replace With text field. Press the REPLACE ALL button to replace all occurrences of the
currently highlighted text with the text you typed in the Replace With text field.

Changing Font Type

Select and highlight a portion of text and press the FONT button ﬁ to adjust size, font type or
style of the highlighted text. You will see the following Font window :

Foats x|
Forts: Sizes:

[ial] 12 | ok |
:Ldg?riQEC'IMT ﬂ ?E ill Cancel |

Architecture 11

— Attributes: — Position:

¥ Nomal [ halic £+ Nomal

[ Bold Strike out ™ Superscript
|Underdining: " Subscript

Changing Font Size
To change the font size for any highlighte

xt select a size in the Size dropdown box.

Changing The Style Of The Text
Change the style of the highlighted text by clicking onto the Attributes radio box. You can
change the appearance of your text by ticking Normal, Italic, Bold, Strike-out.

Bold, lItalic And Underline
Text style can also be adjusted by pressing the BOLD, ITALIC or UNDERLINE speed buttons in
the main operations area :

Bl Bolds highlighted text.
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il - Highlighted text changes to italics.

i’ - Underline highlighted text.

Left, Right, Centre And Justified Text
Text can be aligned to the left, right, the centre or evenly (justified). This is known as text
"alignment"” and can be performed by pressing the following speed buttons :

- Aligns highlighted text to the left.
EI - Aligns highlighted text to the right.
E’ - Aligns highlighted text to the centre.
%’ - Aligns highlighted text to be justified.

Left, Right And Centre Tabs

Tab settings are an easy way of creating "columns™ in your text document. Text can be aligned
to the left, right or centred within each column depending on the type of tab-setting you insert
into your document.

K G2
To set a tab marker in your document first click on the desired Left, Right or Centre TAB speed

button. Now Double-Click on the correct location on your ruler and the appropriate Tab-Marker
will appear. Whenever the Tab key is pressed the cursor will move to this marker and any typed
text will be of the selected alignment (left, right or centre).

Paragraph Formatting
Select Paragraph from the Format Menu to invoke the following Formatting window :
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x|
— Line spacing: — Alignment: ——
¥ Single line ) Left
" One and a haff lines " Right Cancel |
" Centersd
" Justified

— Indents: Distances:
Left: Top IT mm
Right: Bottom: IT mm
First line:

Changing The Linegxacinq

Press either the Single Line, One and a half lines or Two Lines radio buttons to adjust the line
gaps between highlightey text. Alternatively, you can customise the distance between lines by
typing a value into the Frge text field. You can change the scale of this by clicking the In MM
check box on.

Changing Paragraph Indents

Indents refers to the "indentation distance™ you wish to apply to a Highlighted block of text.
You can modify the indentation from the left edge of your text, the right edge or just the
indentation on the first line. To do so click onto the following :

Left: [0.0 : ' i i
eft ™™ _ Click here and enter a value to adjust the left indentation.

Right: |u_u . : o .
9 ™ _ Click here and enter a value to adjust the right indentation.

First line: II]. 1] mm

- Click here and enter a value to adjust the left indentation of the
first line of the highlighted text.

Modifying Paragraph Alignment
See the section Left, right, centre and justified text.

Line Distances
This section refers to distance between the top of the highlighted text and text above it, and the
distance between the bottom of the highlighted text and text below it.

Select the Top text field and enter a value to modify the gap at the top of the highlighted text.
Select the Bottom text field and enter a value to modify the gap at the bottom of highlighted text.
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Hiding / Showing Textual Control Characters

1
Press the CONTROL CHARACTERS speed button to show and hide control characters
in the text area. Showing control characters can be useful when formatting letters with complex
tab settings, or with spacing between blocks of text that are difficult to standardise.

Retrieving / editing a previously saved letter

Step-Ahead automatically organises saved letters according to the patient file that you currently
have open. Retrieving saved letters is as simple as clicking on the Letters / Select Menu drop-
down list. The letter you selected will immediately be retrieved and displayed in the text area.

Templates
Step-Ahead templates are one the most exciting new innovations in practice management today.
Templates are primarily used for letter "Preparation”. Templates are used for two reasons.

e To provide a standardised look and feel for repeatedly written letters.

e To "fill in" the commonly used fields in your letters. For example, a template could be used
to fill in the Name, Address and Phone number of a patient every time you produce referral
letter.

A template is, in itself, just a letter. However, it contains additional "Database Fields" which
are utilised and filled in automatically by Step-Ahead.

Template fundamentals
Three are two phases to creating a Step-Ahead template.

For The First Time (Once Per Template)
e Create a new template.
e Saving your new template.

Every Time You Need To Produce A Letter
e Open the appropriate patient file.

Go to Step-Ahead letters.

Open the appropriate template.
Customise the letter (if required).

Save the template as a letter.

Creating a new template

To create a new template select NEW from the TEMPLATE menu. This will open a new window
and place the cursor in the top left hand corner of the text. You should now enter as much of the
template text as you can. For example, when entering a referral template, you may start by
typing the following:

e The practice letterhead
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The word "Dear"

The words "Thank you for referring"

The words "who presented with"

The words "after successful treatment the excessive..." etc. etc.

Creating a New Template is very similar to creating a new letter, with one exception. The
INSERT DATABASE FIELDS form is now available.

Inserting Database Fields Into A Template

Start at the top of the text you have Entered so far, and start reading your template. Find a point
where it is necessary to enter Database Information and decide what type of Database Field you
require. For example, you may require the Patient Name at the top left hand corner of your
template. In such a case, make sure the cursor is in the correct position.

Now select Patient Name from the DATABASE FIELDS form and press the INSERT button to
insert a direct reference to the appropriate Database Field stored within Step-Ahead. Database
Fields can be anything from the Patient Name to their Referring Specialist or Video Files. The
possibilities of letter writing are endless. Templates can be created to handle anything from the
patient name and address on a simple letter, to sophisticated visual analysis reports containing
full colour stills from their video file.

Databaze Fields E |

Patient

Double-Click on any of the desired Database Fields to insert

g:lgﬁ:s: it into your template. Alternatively, use the UP and DOWN
Sgirf;a‘inﬂgp_'a‘rlﬂﬂ rr arrow keys to highlight the desired database field and press

Do e fesesse the INSERT button to insert it. Press the OK button to finish
Emergency o insertjng database fields and return.

First Mame

Foat Defarmaties
Footwear Anomalies
Full Mame

Group Billing Address
Group Billing Mame
Group Billing Phone
Heatth Fund

Height

Last Mame

Lifestyle

Medical History -

/
v DK & |nzert '/

Complete Database Field Listing
e Address
e Balance
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Chief Complaint
Dermatological Assessment
DOB

Emergency

First Name

Foot Deformities
Footwear Anomalies
Full Name

Group Billing Address
Group Billing Name
Group Billing Phone
Health Fund

Height

Last Name

Lifestyle

Medical History
Name

Notes

Occupation
Orthopaedic History
Other Comments
Patient Type

Patient ID

Phone

Phone Work
Practitioner
Radiographic Evaluation
Referred By

Shoe Size

Somatotype

Specialist Address
Specialist Fax
Specialist First Name
Specialist Last Name
Specialist Last Referral
Specialist Referral Count
Specialist Name
Specialist Phone
Specialist Title
Specialty

Sports History
Today’s Date
Treatment to Date
Videol
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Video2
Video3
Video4
Video5
Video6
Video7
Video8
Video9
Video Title
Visual Gait
Weight

NOTE
When adding Database Fields to a template, remember that the references you are making will
be solely linked to the patient that is currently open.

What A Template Looks Like

Below is a sample template for a simple medical certificate :

Saving A Template
Once you completed
your template press the

Medical Certificate SAVE TEMPLATE speed
== Tadays Dew== Bt
Mamea: << FrstNames=> << | g5t Namas> button ,

Address: << Address>>» _
Step-Ahead will then

Phone: << Phone=> prompt you for a

template filename (no
== First Mame== has been diagnosed with excessive P han 8 ch (
muscular prablerms within the lower led. 4 days rest at home more than 8 ¢ araCters)-
has been recammended. Press the OK button or

the ENTER key to
actually save your
template. You will
notice the extension
"*.sat" is used to name a template. Your template is now available for every patient in Step-
Ahead !l

Regards
== Practitioner==

Using / filling templates to prepare a letter

To utilise a specific template first make sure you have opened the correct patient file. After
entering Step-Ahead letters, simply select the desired template from the Templates Menu. Step-
head will first load the template (as it was originally designed), and then sequentially insert any
database information that the template refers to. For example, after loading the sample medical
certificate (as discussed above) the resultant letter may look like the following:
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Voila ! A complete

Madical Cartificate medical certificate without
207041993 typing a single word !!.
Name: Damien Colings You can continue adding
Address : §16-20 Adex Cf to this letter should you
Qurimbat NSW 2258 need to do so. When you
have finished press the
Phone: 0243627 333 SAVE LETTER button to

Cramien has been diagnosed with excessive muscular store your letter.

prablems withinthe lower leg. 4 daysrest at home has been
recommended.

Regards
Anthaory Gock

Deleting a letter
To delete a letter step through the following :

e Make sure the EDIT TEMPLATE button is up.

e Make sure you have loaded the letter from the Files drop-down list, and that the letter is
visible in the text window.

e Be certain you wish to delete the letter.

e Press the DELETE speed button.

|

The following confirmation box will appear :

@ Delete the current letter?

Press the YES button to delete the currently open letter. Press the NO button to cancel and
continue.

Deleting a template
To delete a template step through the following :

e Make sure the EDIT TEMPLATE button is down.
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e Load the template from the Files drop-down list. The template will be shown at the design
stage.

e Be certain you wish to delete the template.

e Press the DELETE speed button.

it

The following confirmation box will appear :

@ Delete the current letter?

el B

Press the YES button to delete the currently open template. Press the NO button to cancel and
continue.

Performing a spell check

Performing a spell check in Step-Ahead letters is a very simple task. When you completed your
W

document press the SPELL CHECK button . This will automatically execute the spell

check procedure starting from the top left hand corner of your letter. Upon finding an
incorrectly spelled word you will be prompted to repace it.

The misspelled word appears in the Not Found text field. The closest matching replacement
word appears underneath in the Replace With field. Below are explanations of the most useful
choices available :

lgnore ]. Ignore the current spell error, and continue to the next mis-spelled word.
lgnore Al | Ignore all occurrences of the current spell error, and continue to the next

misspelled word.

Roplace | _ Replace the current spell error with the text shown in the Replace With field.

|_Replacean | Replace all occurrences of the current spell error, and continue to the next

misspelled word.

[_Add To Custom | Add the current text in the Not Found field to the custom dictionary. This text
now becomes a valid word to be used in further spell checks.

|_ Cancel Spelicheck | Cancel the current spell check procedure and return.
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NOTE

When a misspelled word is found you can quickly change the erroneous word by
Double-Clicking on any suggestion in the Suggestions drop-down list. Additionally, contact
Trim Systems for details on creating more than one custom dictionary.

Inserting a video analysis image into your letter
There are two ways to insert video analysis images into your letter:

Using Templates To Insert A Video Image

When inserting database fields into templates you will notice there are nine video choices

available.

Databaze Fields Ed |

Specialist Last Referral
Specializt Referral Count
Specializt Mame
Specializt Phone
Specialist Title

Speciality

Todays Date
Treatment to Date
Yideo
Yideo?
Yideo3
“ideod
Yideos
Yideob
Yidea?
Yideod
Yidend
Yizual Gait
Wikt

F

Sports Histary —

\/ 0K g Inzert

Each option is linked to the patient's visual analysis database.
"Videol" referring to the "Still 1". "Video2" referring to
"Still2" etc. etc. To insert an image into a template just

Double-Click on the desired item in the drop-down list.
[

Doing so will display the following image settings window :
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Image Settings E |

Scale Factor % :

a0

Az=zessment Humber :

=

X Cancel

From here you can customise both the size and assessment number
the still will have when used in a template.

Type a value in the Scale Factor text field to set the size
percentage the image will have when displayed. This can range
from 10% through to %200. The default value is 50% of the
image's original size.

Select an assessment number from the Assessment Number drop-
down list. This may be a still from either the patient's first video
assessment, their last video assessment or any assessment from
two to nine. Press the OK button to finalise your settings and insert
the video field into your template.

Insertiing A Video Image Directly From Your Letter

There will be times when you wish to "browse™ through a specific patient's video images and
add them "ad-hoc™ to your letter. When entering a letter, press the INSERT VIDEO IMAGE

speed button:

L2

Inserting an image this way is completely different to inserting an image via a template. You
have the added ability to “browse” through the open patient’s video images before they appear
on the page. This method is intended for use when you are not sure exactly which images are to
be used in the letter.

Pressing the above speed button will display the following window:
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Select Yideo Image Ed |
-
L
Azzezament ;

26/03/1998 7|

Step-Ahead will display the first recorded still in the first assessment for the currently open
patient. This can be changed by clicking on the UP and DOWN buttons Igcated in the top right
hand corner. Additionally the visible assessment can be changed by Clicking on the Assessment
drop-down list and selecting another date. Double-Click directly onto the image to insert it into
your letter. This process can be repeated as many times as needed.

Inserting images from an external source
Step-Ahead letters will also display standard windows images when needed. Such images must

have been saved using the ".bmp" extension. To insert an image select IMAGE from the Insert
Menu. You will be presented with the following :

Open EHE

File name: Folders: “ . .
Im c-Astepdiph _ Choose the image file
_ you wish to insert and
Eg:ﬁ“ﬂ:l;';'“" A Qe — Double-Click to insert
clear.bmp = 1 net Network... it into your document.
compare.bmp "F‘f
copy_bmp [ priv
crdfilel_bmp " Read only
cut.bmp =
delete_bmp ﬂ —I
Ligt fileg of type: Drives:

|Bitmap Files N EEEEEIE
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Images From The Clipboard
Alternatively, you can insert any image stored in the clipboard using the PASTE speed button

(as discussed above). This makes it possible to use alternative sources to obtain your image and
use that in your letter with minimum of fuss.

Changing the view size(print preview)
You can adjust the size of the visible text window by pressing the PRINT PREVIEW button.

2]

This will toggle between 25%, 50%, 75% and 100% view modes.
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